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№ Название 

1 GSM Антенна 

2 Магнитное основание 

3 Кабель антенны 

4 Разъем SMS для GSM антенны 

5 Индикаторы статуса 

6 Держатель SIM карты 

7 Отверстия фиксации платы 

8 SIM карта 

9 Разъем кабеля для программирования с ПК 

10 Клеммная колодка 

11 Отверстие для кабеля антенны 

12 Отверстия крепления металлического кронштейна 

13 Металлический кронштейн 

14 Пластиковые стойки крепления платы 

 

 
Рис. 1. Компоненты 
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Серия коммуникаторов GS3100 разработана и изготовлена с учетом высоких стандартов качества и 
производительности. Производитель рекомендует, чтобы установленная система тестировалась не 
реже одного раза в месяц. DSC не несет ответственности за повреждения, вызванные неправильной 

установкой изделия или обслуживанием неквалифицированным персоналом. 
DSC оставляет за собой право изменять технические характеристики изделия без предварительного 

уведомления. 

 
Информация по утилизации 

DSC рекомендует пользователям утилизировать продукцию (контрольные панели, извещатели, 
сирены и другие устройства) согласно региональным нормам по утилизации. Основным методом 

является повторное использование частей или всех изделий и переработка продукции, компонентов 
и/или материалов.  

Дополнительную информацию смотрите на www.dsc.com. 
 

Директива по утилизации электрических и электронных изделий (WEEE) 
В Европейском Союзе, этот значок показывает, что изделие не должно утилизироваться в 

обычных мусорных контейнерах. Оно должно утилизироваться в специальных местах, 
обеспечивающих возможность последующего восстановления или переработки. 

 
Дополнительную информацию смотрите на www.dsc.com. 

 
Для программирования изделия используйте ПО GS3100 Console версии 1.0.0 или выше. 
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ВВЕДЕНИЕ 
GS3100 является GSM коммуникатором, который, в отсутствие телефонной линии, передает 
голосовые или цифровые сообщения через GPRS канал на приемники System III или System II или на 
ПК с ПО WinBCS (версии 2.0 и выше). GS3100 производится в одном варианте: 
GS3100-K. Набор содержит GSM плату, антенну с кабелем 2 метра и металлический кронштейн. 
Информация по специфическим моделям будет помечена номером модели в тексте. Термин 
«коммуникатор» используется для описания функциональности модели. 
Эта инструкция описывает программирование и работу коммуникатора GSM/GPRS. 
 Это изделие является стационарным и должно устанавливаться только квалифицированным 

персоналом (квалифицированным считается персонал, прошедший соответствующее 
обучение и имеющий опыт, необходимый для минимизации рисков, возможных при выполнении 
задач установки и рисков для других людей). Изделие должно устанавливаться и 
использоваться в условиях, обеспечивающих уровень воздействия 2, категории питания II, в 
безопасных условиях, только в помещениях. Эта инструкция должна использоваться с 
инструкцией по установке контрольной панели. Следует изучить все пункты данной 
инструкции. 

Функции 
 Имитация проводной линии 
 Автоматическое переключение на сеть GSM при отключении проводной линии 
 Контроль и индикация входящих и исходящих вызовов 
 Индикация уровня GSM сигнала 
 3 программируемых выхода с открытым коллектором 
 Защита от перенапряжений по проводной линии 
 4 диапазона частот GSM 
 Антенна с магнитным основанием 
 Поддержка формата Contact ID по каналу GPRS при подключении к контрольной панели 
 Связь через GPRS/Интернет с приемниками Sur-Gard System III или System II. 
 4 номера телефона для передачи Contact ID  
 До 100 номеров телефонов (до 16 цифр каждый) для управления выходами 
 Дистанционное управление по идентификации входящего номера 
 Программирование опций с ПК 
 

Технические характеристики 
Питание может обеспечиваться контрольной панелью или дополнительным источником питания (не 
поставляется). 
 

Напряжение питания От 9,6 до 27,6 В постоянного тока 

Потребление в режиме ожидания Не более 100 мА (за исключением выходов) при 
13,8 В 

Потребление в режиме тревоги (передачи) Не более 200 мА (за исключением выходов) при 
13,8 В 

Выходы 3 выхода с открытым коллектором, 100 мА 

Рабочая частота 900/1800 МГц или 850/1900 МГц 

Максимальное сопротивление шлейфа с 
устройствами, подключенными последовательно 
LI 

1 кОм 

Максимальное количество устройств, 
подключаемых параллельно к LI 

2 

Рабочая температура +5 +40 град.С 

Размеры печатной платы 60,45 х 142 мм 

Вес печатной платы 77 г 
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Назначение 
Коммуникатор передает сообщения на пульт централизованной охраны (ПЦО) и может имитировать 
проводную телефонную линию в случае ее неисправности или использовать только GSM канал для 
передачи данных в местах, где проводные телефонные линии отсутствуют.  
Коммуникатор может передавать сообщения по сети данных GPRS. Это обеспечивает быструю и 
надежную передачу на ПЦО с приемниками Sur-Gard System III или System II или на WinBCS (версии 
2.0 и выше). 
Работа коммуникатора сильно зависит от зоны покрытия сети GSM, поэтому он не должен 
устанавливаться без предварительного тестирования положения антенны для определения 
оптимального места установки (не менее одного зеленого индикатора должно быть включено). 
Коммуникатор имеет 3 выхода, один из которых может активизироваться удаленно, другие два 
выхода могут использоваться для индикации неисправностей проводной телефонной линии или сети 
GSM. 
В GSM сети коммуникатор может использоваться только по своему назначению, его нельзя 
использовать как модем для передачи факсов или данных телеметрии. 

ИДЕНТИФИКАЦИЯ СОСТАВНЫХ ЧАСТЕЙ 
Цифры в квадратных скобках [ ] в инструкции относятся к составным частям коммуникатора (смотрите 
рис. 1). 

УСТАНОВКА КОММУНИКАТОРА 
 Не прокладывайте кабели по плате коммуникатора. 
 Этот коммуникатор должен устанавливаться только квалифицированным персоналом, 

в сухом и безопасном месте, вдали от радиопередающей аппаратуры. 
 Этот коммуникатор представляет собой плату, устанавливаемую в корпус 

контрольной панели, желательно имеющей металлический корпус, и антенны, 
подключаемой к плате коаксиальным кабелем. При нормальной работе, эти элементы 
(плата, антенна и кабель) могут излучать электромагнитные поля и, если рядом 
имеются электронные устройства, чувствительные к таким полям, они могут иметь 
нарушения в своей работе. По этой причине рекомендуется размещать плату 
максимально далеко от таких электронных устройств и размещать антенну на 
внешней части металлического корпуса или на металлическом кронштейне, вдали от 
корпуса. Рекомендуется оставлять в корпусе панели минимальное количество 
коаксиального кабеля и размещать его вне корпуса панели.  

 Проверьте уровень сигнала GSM перед установкой коммуникатора в выбранном месте. 
 

GS3100-K 
1. Открутите винты крышки контрольной панели и снимите крышку. 
2. Выберите место внутри корпуса контрольной панели для установки платы, не забудьте про 

подключаемые кабели. 
3. Расположите 4 клейкие пластиковые стойки [14] на корпусе панели и наденьте плату 

коммуникатора отверстиями [7] на эти стойки, как показано на рисунке 2. 
4. Установите антенну снаружи корпуса.  
4 а. Расположите антенну [1] на верхней части металлического корпуса (рис. 2), чтобы магнитное 

основание [2] прикрепилось к поверхности. Проведите кабель антенны через отверстие в 
металлическом корпусе панели. 
Если необходимо, можно использовать металлический кронштейн [13] (рис. 3а) 
Закрепите металлический кронштейн [13] к подходящему основанию, используя монтажные 
отверстия [12]. Разместите антенну [1] на верхней части металлического корпуса (рис. 3а), 
чтобы магнитное основание [2] прикрепилось к поверхности. Проведите кабель через 
отверстие [11] в металлическом кронштейне [13]. 

 
В зависимости от индивидуальных требований, возможно приобретение и использование следующих 
антенн: 
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Дополнительная антенна ANT-EU 
4 б. Подробности по использованию антенны ANT-EU (рис. 3б) смотрите в инструкции на антенну. 
 

5. Подключите кабель [3] к разъему GSM [4] коммуникатора. 
6. Выполните подключения к клеммной колодке [10] 
7. Согласно указанию стрелки, установите SIM карту [8], лицевой стороной вниз в держатель SIM 

карты (рис.1). 
PIN SIM карты должен быть отключен перед установкой карты в коммуникатор. 
8. Убедитесь, что все зеленые индикаторы мигают при включении коммуникатора, это означает 

процесс инициализации коммуникатора. 
 
 
 
 

 
 
Рис.2 Установка платы коммуникатора в корпус контрольной панели. 
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9. Проверка уровня сигнала 
 Убедитесь, что хотя бы один зеленый индикатор включен, все включенные зеленые 

индикаторы показывают отличный уровень сигнала. 
 Если зеленые индикаторы не включены, уровень сигнала СЛИШКОМ СЛАБЫЙ, изменяйте 

положение антенны, пока не добьетесь нормального уровня сигнала. 
10. Закройте крышку корпуса контрольной панели. 

 
Подключайте питание только после надежного закрепления корпуса на конструкции здания 
и подключения его к цепям заземления. 
 
Перед установкой или удалением SIM карты обязательно отключайте питание 
коммуникатора. 

ПОДКЛЮЧЕНИЕ КОММУНИКАТОРА 
Эта глава описывает клеммы коммуникатора. На рисунке 4 приведена типовая схема подключения. 
+V (1) Питание от контрольной панели или от отдельного источника питания (опция), напряжение от 

9,6 В до 27,6 В, убедитесь в наличии защиты этой слаботочной сети согласно стандарту EN 
60950-1-2006. 
Для подключения источника питания кабелем «витая пара» не более 2 м, сечением 
0,75 кв.мм. Для более короткого кабеля используйте соответствующую витую пару. 

(2) Минус питания и общий провод для программируемых выходов с открытым коллектором. 
T1 (3), Т2 (4) – Выходы с открытым коллектором, активизируются по неисправностям телефонной 

линии или сети GSM. 
Т3 (5) – Программируемый выход с открытым коллектором, может активизироваться по 

идентификации номера входящего вызова. Максимальная нагрузка каждого выхода с 
открытым коллектором не должна превышать 100 мА. 

 (6) Клемма заземления – подключается к шине заземления для обеспечения Стандарта 
безопасности телекоммуникационных сетей. 

LE (7-8) Входящая телефонная линия – к клеммам подключается входящая телефонная линия. 
LI (9-10) Внутренняя телефонная линия – к клеммам подключается контрольная панель или другой 

коммуникатор. 
 
Нагрузка выходов с открытым коллектором не должна превышать 100 мА. Если 
требуется большая нагрузка, используйте реле. 
 

 
Рис. 3 – Установка антенны на металлический кронштейн или антенны ANT-EU. 
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ИНДИКАТОРЫ СТАТУСА 
На печатной плате имеется 5 индикаторов: три зеленых индикатора (1, 2 и 3), один желтый индикатор 
(4) и один красный индикатор (5). Они показывают подключение, передачу и неисправности (смотрите 
рисунок 5). 
 
Во время инициализации коммуникатора и его программирования индикаторы мигают. 
 
Красный – этот индикатор нормально выключен. Он показывает неисправности количеством вспышек. 
При включении питания, коммуникатор проверяет наличие неисправностей. Наиболее важные 
неисправности отображаются соответствующим количеством вспышек этого индикатора (5).  
 

Номер неисправности Описание неисправности Количество вспышек 

1 Сбой прошивки (неверная прошивка) 1 

2 Сбой питания 2 

3 Сбой модуля GSM 3 

4 Сбой SIM 4 

5 Слабый уровень сигнала GSM 5 

6 Сбой GPRS 6 

7 Приемник недоступен 7 

8 Не обнаружен приемник 1 ПЦО 8 

 Нет неисправностей Выкл. 

 
Желтый – этот индикатор включается, когда коммуникатор подключается к сети GSM (из-за сбоя 
проводной линии). Если он быстро мигает, это показывает наличие вызова в GSM сети (входящего 
или исходящего). 
Зеленые – имеется три зеленых индикатора (1,2 и 3), показывающих уровень GSM сигнала (смотрите 
рисунок 5).  
Первый индикатор (1) находится около монтажного отверстия. Если он выключен, сеть GSM 
недоступна (не обслуживается). Если он включен, уровень сигнала слабый, но достаточный для 
обслуживания связи. 
Второй индикатор (2). Если он включен, уровень сигнала хороший. Этот индикатор может включиться 
только, если зеленый индикатор 1 включен. 
Третий индикатор (3). Если он включен, уровень сигнала GSM отличный. Этот индикатор может 
включиться только, если оба зеленых индикатора 1 и 2 включены. 
 

 

Индикаторы уровня GSM сигнала 
Символ уровня GSM сигнала 

Индикаторы статуса 

Нумерация индикаторов 
Нумерация индикаторов не приведена на 

печатной плате. Она приводится только для 
облегчения понимания назначения каждого 

индикатора в этой инструкции. 
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ПРИНЦИПЫ РАБОТЫ 
Коммуникатор предоставляет возможность выбора «Первичного канала» для связи. Коммуникатор 
определяет входящие вызовы и декодирует тональный набор (DTMF) номера. Имитация телефонной 
линии позволяет использовать коммуникатор как основной канал передачи данных или как резервный 
канал, при сбое проводной телефонной линии. 
Переключение между проводной линией и GSM НЕ происходит во время исходящих вызовов. 
 
Коммуникатор не декодирует импульсный набор номера. 
 
Для предотвращения нежелательного использования имитации телефонной линии по GSM, 
коммуникатор выдает сигнал в виде двойных звуковых сигналов при голосовом вызове. 
Первый двойной сигнал выдается через 5 минут и далее повторяется с интервалом 30 
секунд. 
 

Приоритет проводной линии 
Если напряжение проводной телефонной линии на клеммах LE падает ниже 3 В на время от 10 до 
3600 секунд (программируемое значение), коммуникатор переключит подключенные устройства (к 
клеммам LI) к сети GSM.  
При восстановлении телефонной линии, он переключится обратно, на проводную телефонную линию, 
через запрограммированное время. 
 

Приоритет GSM канала 
Если имеется GSM сеть, устройства, подключенные к клеммам LI, будут работать с имитируемой 
телефонной линией в сети GSM. Если нет GSM сети, подключается проводная телефонная линия 
 

Процедура передачи Contact ID через GPRS 
Коммуникатор, если введены номера телефонов на странице GPRS -> Telephone numbers to decode 
в программном обеспечении (ПО) GS3100 Console, направляет вызовы на эти номера по сети GPRS. 

 По наступлению события, контрольная панель занимает телефонную линию. 
 Коммуникатор выдает сигнал станции (гудок). 
 Контрольная панель набирает номер ПЦО. Проверьте, что панель добавляет не менее 1 

секунды паузы или ожидает сигнала (гудка) перед набором номера. 
 Коммуникатор выдает сигнал запроса, соответствующий протоколу передачи Contact ID. 
 После получения сигнала запроса, контрольная панель передает код сообщения в формате 

DTMF (Contact ID). 
 Коммуникатор декодирует и преобразует цифры DTMF в пакеты и передает их на приемник 

Пульта Централизованной Охраны (ПЦО) через сеть GPRS. 
 Приемник подтверждает прием сообщения о событии и передает команду на коммуникатор 

для генерации соответствующего сигнала подтверждения для контрольной панели. 
 После того, как коммуникатор выдал сигнал подтверждения, панель отключается от 

телефонной линии, если более не требуется передавать сообщения, или передает 
следующее сообщение. 
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АКТИВИЗАЦИЯ ВЫХОДОВ 
Коммуникатор имеет три выхода, управляемых автоматически, по событию или удаленно, при приеме 
входящих вызовов с запрограммированных номеров телефонов. 

Включение/Выключение выходов 
Выходы с открытыми коллекторами Т1, Т2 и Т3 включаются автоматически по следующим событиям: 

 Т1 – сбой телефонной линии (отсутствие напряжения) 
 Т2 – сбой сети GSM (нет сигнала, блокировка) 
 Т3 – входящий вызов с запрограммированного номера телефона 

 
Если выход включается автоматически, он не восстанавливается, пока не восстановлена 
причина включения. 

Удаленное включение и выключение выхода 
Выходы с открытым коллектором Т1 и Т2 являются БИСТАБИЛЬНЫМИ, выход Т3 является 
МОНОСТАБИЛЬНЫМ (при активизации, моностабильный выход отключается по истечении 
запрограммированного времени On Time). 

Моностабильные выходы 

Моностабильный выход Т3 может активизироваться следующим образом: 
1. Бесплатным вызовом с запрограммированных номеров телефонов. Коммуникатор включает 

выход без ответа на вызов. 
Время On Time (время включения выхода) может быть запрограммировано в интервале от 1 до 
86400 секунд с шагом в 1 секунду. 
 

ПРОГРАММИРОВАНИЕ КОММУНИКАТОРА 
Для правильной работы коммуникатора, используйте SIM карты с памятью 32 к или более. 
 
Для программирования используйте кабель PC-Link (рис. 6), подключив его к разъему [9] 
коммуникатора и СОМ порту ПК, также требуется ПО GS3100 Console. 
После подключения кабеля PC-Link, установите в ПО номер СОМ порта компьютера через меню 
Options -> Serial Ports. 
 
 

 
 

Рис. 6. Схема подключения кабеля PC-Link 
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Просмотр настроек коммуникатора 

Для просмотра настроек коммуникатора, используйте значок Upload from board  

Загрузка настроек коммуникатора 

После выполнения программирования или внесения изменений в выгруженные настройки, загрузите 

данные в коммуникатор с помощью значка Download to board  

Предварительные действия 

При запуске программы, откроется основное окно: если вы используете мышь, нажмите на опцию 
меню Untitled #1 в левой верхней части окна, появятся два окна. 
 
 В окне общих параметров будут следующие разделы: 
 

Panel settings (параметры объекта): в этом разделе можно посмотреть и изменить параметры 
объекта (пользователя) с помощью следующей процедуры: 

1. Нажмите левую кнопку мыши на значке.  
2. Введите или измените информацию о пользователе, системе и объекте. Для подтверждения и 

сохранения нажмите  

 Upload from board (выгрузка из коммуникатора). При нажатии на значок, данные, 
запрограммированные в коммуникаторе, выгружаются в ПК. 

 Download to board (загрузка в коммуникатор). При нажатии на значок, 
запрограммированные в ПО данные, загружаются в коммуникатор. 

 Factory Defaults (Заводские установки). При нажатии на значок, устанавливаются заводские 
значения настроек. 

 Board reset (сброс коммуникатора). При нажатии на значок, коммуникатор перезапускается. 
 
 В окне GS3100 можно найти следующие разделы: 
 

 Phonebook (телефонная книга). Страница списка номеров телефонов. 

 Options (Опции). Страница настройки опций. 

 GPRS. Страница настроек параметров GPRS. 

 Status (Статус). Страница отображения текущего статуса коммуникатора. 
 
Для начала программирования нового объекта, выберите File -> New Customer. 
Для отображения списка объектов, сохраненных в архиве, выберите в меню File -> Open. Этот пункт 
позволяет вам удалять и просматривать файлы объектов следующим образом:  

1. Нажмите правой кнопкой мыши на названии объекта (пользователя) 

2. Нажмите Load  для загрузки данных объекта с жесткого диска или удалите файл 

нажатием Delete selected customer / 
Вы можете загрузить данные объекта двойным нажатием на названии объекта в списке. 
Вы можете просматривать список файлов объектов по алфавиту или пультовому номеру, 
нажимая на соответствующий заголовок колонки списка файлов. 

 
Данные настроек сгруппированы в следующие страницы. Страница Status (Статус) предназначена 
для просмотра статуса. Подробное описание страниц настроек приводится ниже. 
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Phonebook (Телефонная книга) 
В телефонной книге могут храниться до 100 номеров телефонов. 

Telephone Numbers (номера телефонов 

 Description (Описание): введите описание, до 16 символов. 
 Telephone number (Номер телефона): введите номера телефонов до 16 цифр, с правильным 

кодом страны в формате «+ххх» (допустимы только цифры и символ «+»). 
 Activates Output (Активизирует выход): укажите для номеров телефонов, которые должны 

активизировать выход Т3, когда коммуникатор принимает входящий вызов с этого номера. Эта 
функция не зависит от опций White List (Белый список) и Black List (Черный список) 
(страница Options -> Dial options). 

 White List (Белый список): разрешите  или запретите Белый список, позволяющий 
коммуникатору принимать или отклонять входящие вызовы. Режим работы опции Белого списка 

связан с включением  или выключением  Black List (Черный список), который имеется в 
(страница Options -> Dial options). Связь показана в таблице ниже. 

 

Белый список Черный список Режим работы 

  Прием входящих вызовов с любого номера телефона 

  Отклонение любых входящих вызовов 

  
Прием вызовов только с номеров из Белого списка, отклонение 
вызовов с любых других номеров телефонов. 

 

Options (Опции) 
Эта страница используется для установки опций коммуникатора. 
 

Dial options (набор номера) 

Эта часть используется для программирования отдельных параметров для используемых номеров 
телефонов. 
 Prefix (Префикс): коммуникатор будет добавлять цифры, введенные в это поле, для всех номеров 

телефонов, набираемых через функцию GSM Interface. Если необходимо, введите префикс (не 
более 8 цифр) в это поле. Если префикс не требуется, оставьте поле пустым. 

 Digits to Remove (Удаляемые цифры): если коммуникатор подключен через местную АТС, номер 
телефона (запрограммированный в контрольной панели) должен иметь префикс выхода в город 
(обычно одна цифра). Поскольку этот префикс выхода в город не нужен для передачи по сети 
GSM, его нужно удалить из номера телефона. Введите количество цифр для удаления (например, 
если для выхода в город набирается 01, введите 2 – количество цифр префикса для выхода в 
город). 

Номер телефона должен быть на две цифры больше, чем количество удаляемых цифр, 
иначе будет выдан сигнал занятости, например: 
 - набираемый номер телефона 0123, удаляются две цифры = верно, будет набран номер 
телефона 23. 
 - набираемый номер телефона 123, удаляются две цифры = сигнал занятости, оставшийся 
номер телефона 3.  
 Enable Black List (Разрешить Черный список): Установите галочку, если не хотите принимать 

вызовы от запрограммированных в телефонной книге номеров телефонов, будут приниматься 
звонки только от телефонов, для которых установлена галочка Белый список.  

http://www.senk.ua/
mailto:office@senk.ua


 ТОВ СП «СЕНК»; www.senk.ua; office@senk.ua      GS3100 
 

 14 

Generic (Общее) 

Этот раздел может использоваться для установки уровней громкости динамика и микрофона, 
подключенных к GSM передатчику. 
 
 Speaker Volume (Громкость динамика): громкость динамика меняется перемещением указателя. 
 Microphone Volume (Громкость микрофона): громкость микрофона меняется перемещением 

указателя. 
 Tones… (Тоны): выберите название страны, где устанавливается коммуникатор: каждая страна 

имеет свои нормы, выбор обеспечивает правильную работу имитируемой телефонной линии. 
 LE failure timeout (время сбоя LE): время, в секундах (от 10 до 3600 секунд), в течение которого 

должна отсутствовать телефонная линия, чтобы отобразился сбой телефонной линии. 
Это время можно увеличить до 60 секунд, если к линии LI подключены телефонные 
устройства. 
 LE restore timeout (время восстановления LE): время, в секундах (от 10 до 3600 секунд), в 

течение которого должна присутствовать телефонная линия, чтобы отобразилось восстановление 
телефонной линии. 

Outputs (Выходы) 

Этот раздел может использоваться для настройки режимов работы выходов. 
 Output 3 ON Time (Время ВКЛ выхода 3): время включения выхода, в секундах (0-86400). 
 Output 1, Output 2, Output 3 (Выход 1, 2, 3): установите галочку, выход нормально замкнутый или 

нормально разомкнутый. 
 Primary Path (Основной канал): выберите основной канал связи GSM или проводная линия. 
 

GPRS 
Этот раздел содержит настройки опций GPRS. 
 
Помните о задержках, которые могут возникать при передаче через GPRS и вызываться 
активностью администраторов сети. Мы рекомендуем устанавливать количество 
попыток передачи максимальным, столько, сколько может передавать контрольная 
панель и использовать резервный номер телефона для передачи сообщений через GSM, так 
же, как и через GPRS. 

Access Point Name 1 and Access Point Name 2 (Имена точек доступа 1 и 2) 

Введите имя точки доступа провайдера услуг GPRS. Введите имя или IP адрес точки доступа. Точка 
доступа 2 используется как резерв для точки доступа 1. 

Receiver 1, Local Port 1 and Remote Port 1 IP address (IP адрес и локальный порт 
приемника 1)  

Введите IP адрес и номер порта первого приемника. Используйте тот же адрес и порт, которые есть в 
разделе Listening Port ПО WinBCS, для приемников Sur-Gard System III и System II вводите IP адрес и 
порт, заданные в них. 

Receiver 2, Local Port 2 and Remote Port 2 IP address (IP адрес и локальный порт 
приемника 2)  

Введите IP адрес и номер порта второго приемника, использующегося как резервный приемник. Эти 
параметры можно задать, если введены параметры приемника 1. Разрешение контроля и время 
контроля не относится к приемнику 2. 

APN1 Username and Password, APN2 Username and Password (Имя и пароль для 
точек доступа 1 и 2) 

Некоторые провайдеры требуют ввода имени и пароля для авторизации. Если необходимо, введите 
эту информацию в указанные поля для точек доступа 1 и 2. 
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Telephone numbers to decode (номера телефонов для декодирования) 

В эти поля можно ввести до 4 номеров телефонов, набираемых контрольной панелью (номер должен 
содержать не менее 2 цифр). Если коммуникатор опознает вызов по этим номерам, автоматически 
включается передача через GPRS. Если номер не соответствует запрограммированному, передача 
осуществляется через голосовой канал. Если номера телефонов не введены, коммуникатор будет 
работать только по проводной линии и голосовому каналу GSM. 
 
ВНИМАНИЕ: Поле Удаляемые цифры может определять, будет использоваться голосовой канал или 
GPRS, например: 
 

1. Если панель набирает номер телефона 0123, задано количество цифр для удаления 2 и 
введен номер для декодирования 0123, коммуникатор не определит номер и будет 
использовать голосовой канал GSM. 

2. Если панель набирает номер телефона 000123, задано количество цифр для удаления 2 и 
введен номер для декодирования 0123, коммуникатор определит номер и будет использовать 
канал GPRS. 

 

DNIS 

Если требуется, введите номер сервиса определения номера телефона 
 

Account Code (Пультовой номер) 

Пультовой номер нужен для связи с ПО WinBCS или приемниками Sur-Gard System III и System II. 
Введите в это поле пультовой номер. 

Enable Supervision (Разрешение контроля) 

Для разрешения контроля, установите галочку. Контроль возможен только для основного приемника 
(приемник 1). 

Supervision Time (Время контроля) 

Задайте время контроля. Допустимые значения от 1 секунды до 65535 секунд с шагом 1 секунда. 

Status (Статус) 
В этом разделе вы можете контролировать статус коммуникатора в реальном времени и управлять 
некоторыми функциями. 
 
ВНИМАНИЕ:  Информация обновляется каждые 5 секунд. 
 

Раздел статуса 

Этот раздел содержит наиболее важную информацию, относящуюся к модулю GSM. Виртуальный 
дисплей показывает, кроме названия сети GSM, уровень сигнала GSM (на отдельном индикаторе). 
Индикаторы статуса устройства могут быть включены или выключены. Индикаторы обычно зеленые, 
если они красные, нет связи между коммуникатором и ПО. Если индикатор желтый, запрашиваются 
данные о статусе. 
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